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SENSORS & SOFTWARE INC. PRODUCT LICENSE, COPYRIGHT, LIABILITY AND WARRANTY 

INFORMATION 

Important 

Please read this document carefully before using the SOFTWARE PRODUCT or assembling the HARDWARE 

PRODUCT. By using the storage media or assembling the hardware, you are agreeing to be bound by the 
terms of this agreement. If you do not agree to the terms of this agreement, promptly contact Sensors & 
Software, Inc. at the address indicated at the end of this document. 

Definition 

The word PRODUCT as used herein defines any item sold by Sensors & Software, Inc. and may be 
comprised of HARDWARE PRODUCT which consists of physical objects and SOFTWARE PRODUCT which 

means computer programs, codes and related support materials. 

Software Product License Agreement 

In order to preserve and protect its rights under the applicable laws, Sensors & Software, Inc. (hereafter 
SSI) does not sell any rights to its Software products. Rather, SSI grants the right to use its software, 
diskettes (or other storage media) and documentation (hereafter collectively called SOFTWARE PRODUCT) 
by means of a SOFTWARE PRODUCT license.  You acknowledge and agree that SSI retains worldwide title 
and rights to all its software and that the SOFTWARE PRODUCT contains proprietary materials protected 

under copyright, trademark and trade secret laws. 

Grant of Software Product License 

In consideration of payment of the license fee which is the price you pay for the SOFTWARE PRODUCT and 
your agreement to abide by the terms and conditions of this License Agreement, SSI grants to you, the 
Licensee, a non-exclusive right to use the SOFTWARE PRODUCT under the following conditions: 

You may: 

 use the SOFTWARE PRODUCT on a single workstation owned, leased or otherwise controlled by 
you; 

 copy the SOFTWARE PRODUCT for backup purposes in support of your use of the product on a 
single workstation. 

You may not: 

 copy, distribute or sell copies of the SOFTWARE PRODUCT or accompanying written materials, 
including modified or merged SOFTWARE PRODUCT to others; 

 sell, license, sublicense, assign or otherwise transfer this license to anyone without the prior 
written consent of SSI; 

 modify, adapt, translate, decompile, disassemble or create derivative works based on the 
SOFTWARE PRODUCT. 

Termination 

This license is effective until terminated. You may terminate the license at any time by returning the 
SOFTWARE PRODUCT and all copies to SSI.  The license will automatically terminate without notice by SSI if 
you fail to comply with any terms or conditions of this agreement.  Upon termination, you agree to return 
all copies of the SOFTWARE PRODUCT to SSI. 

Update Policy 



SSI may create, from time to time, updated versions of its SOFTWARE PRODUCT.  At its option, SSI will 

make such updates available to licensees who have paid the update fee. 

Product Warranty, Limited Remedy and Limited Liability  

SSI warrants the PRODUCT to be free from defect in material and workmanship under normal use for a 
period of one year (365 days) from the date of shipment.  Any third party computer systems or other items 
not manufactured directly by SSI purchased with any PRODUCT or independently from SSI are subject to 

the original manufacturer's warranty and are not the responsibility of SSI. 

SSI makes no other warranties including, but not limited to, any implied warranty of merchantability or 
fitness for a particular purpose.  If this product is defective within the warranty period stated above, your 
exclusive remedy shall be, at SSI’s option to replace or repair the SSI product or refund the purchase 
price of the SSI product.  Except where prohibited by law, SSI will not be liable for any loss or damage 
arising from this SSI product, whether direct, indirect, special, incidental or consequential regardless of 
the legal theory asserted. 

All statements, technical information, and recommendations related to SSI products are based on 
information believed to be reliable, but the accuracy or completeness is not guaranteed.  Before using this 
product, you must evaluate it and determine if it is suitable for your intended application.  You assume all 
risks and liability associated with such use.  Any statements related to the product, which are not 
contained in SSI current publications, or any contrary statements contained on your purchase order shall 
have no force or effect unless expressly agreed upon, in writing, by an authorized officer of SSI. 

SSI warrants the diskettes or other storage media on which the SOFTWARE PRODUCT is furnished to be free 
from defects in material and workmanship under normal use for a period of ninety (90) days from the date 
of purchase as evidenced by a copy of your invoice. 

Except as specified above, any SOFTWARE PRODUCT is provided "as is" without warranty of any kind, either 
expressed or implied, including, but not limited to, the use or result of use of the product in terms of 
correctness, accuracy, reliability, currentness or otherwise. The entire risk as to the results and 
performance of the PRODUCT is assumed by you. If the PRODUCT is defective or used improperly, you, and 
not SSI or its dealers, distributors, agents, or employees, assume the entire cost of all necessary 
servicing, repair or correction. 

SSI's entire liability and your exclusive remedy for SOFTWARE PRODUCT shall be, at SSI's option, either: 

 the replacement of any diskette or hardware components which do not meet SSI's Limited 
Warranty and which are returned to SSI postage prepaid with a copy of the receipt, or 

 if SSI is unable to deliver a replacement diskette which is free of defects in material or 
workmanship, Licensee may terminate this agreement and have the license fee refunded by 
returning all copies of the SOFTWARE PRODUCT postage prepaid with a copy of the receipt. 

If failure of any PRODUCT resulted from accident, abuse or misapplication, SSI shall have no responsibility 
to replace the SOFTWARE PRODUCT, refund the license fee, or replace or repair the HARDWARE PRODUCT. 

Do not tamper with any PRODUCT.  PRODUCT contains no user serviceable parts.  If tampering is 
evident in SSI’s opinion, warranty is void and null. 

No oral or written information or advice given by SSI, its dealers, distributors, agents or 
employees shall create a warranty or in any way increase the scope of this warranty and you may 
not rely on any such information or advice. 

Neither SSI nor anyone else who has been involved in the creation, production or delivery of the 
PRODUCT shall be liable for any direct, indirect, special, exemplary, incidental or consequential damages, 
claims or actions including lost information, lost profits, or other damages arising out of the use or inability 
to use this PRODUCT even if SSI has been advised of the possibility of such damages. 



This warranty gives you specific rights.  You may have other rights which vary from province to province, 
territory to territory and certain limitations contained in this limited warranty may not apply to you. 

General 

No right, license, or interest to any SSI trademarks is granted hereunder with the purchase of the 
PRODUCT or the SOFTWARE PRODUCT license. 

Governing Law 

In the event of any conflict between any provision in this license agreement and limited warranty and any 
applicable provincial legislation, the applicable provincial legislation takes precedence over the 
contravening provision.  This agreement shall be governed and construed in accordance with the laws of 
the Province of Ontario, Canada.
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Serviceability 

Should any term of this agreement be declared void or not enforceable by any court of competent 
jurisdiction, the remaining terms shall remain in full effect. 

Waiver 

Failure of either party to enforce any of its rights in this agreement or take action against any other party 
in the event of a breach of this agreement shall not be considered a waiver of the right to subsequent 
enforcement of its rights or actions in the event of subsequent breaches by the other party. 

Acknowledgement 

You acknowledge that you have read this agreement, understand it and agree to be bound by its terms 
and conditions. You further agree that this agreement is the complete and exclusive statement of 
agreement between the parties and supersedes all proposals or prior agreements oral or written between 
the parties relating to the subject matter of this agreement. 

Should you have any questions concerning this agreement, please contact in writing: 

Sensors & Software Inc. 
1040 Stacey Court 

Mississauga, Ontario 
Canada L4W 2X8 

Tel:(905) 624-8909 
Toll Free: 1 800 267-6013 

Fax:(905) 624-9365 
E-mail: radar@sensoft.ca 

pulseEKKO, Noggin, SpiView, SnowScan, Conquest, SmartCart, SmartHandle, RoadMap, Conquest for Windows, ConquestView, 
Win_EKKO, EKKO_Mapper, EKKO_3D and EKKO_POINTER ARE TRADEMARKS OF SENSORS & SOFTWARE INC.  
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1 Overview 

Sensors & Software have created SPIDAR, a family of devices that enable networking of GPR 

systems for a wide variety of new and powerful applications. SPIDAR allows networking of any 

number of Noggin and pulseEKKO PRO GPR units together to create virtually any multi-channel 

GPR deployment imaginable. 

Noggin and pulseEKKO PRO GPR systems are networked using SPIDAR devices known as 

Network Interface Controllers (NICs).  A NIC is a microprocessor based module that provides 

complete access and control over a Noggin or a pulseEKKO PRO unit along with peripherals 

such as odometers and GPS units.  The NIC communicates with the PC via Ethernet or Wi-Fi. 

When a multiplicity of NICs operate together simultaneously, a SPIDAR hub is used to 

coordinate communications, manage power and synchronize positioning to the individual NICs 

and their associated GPR units. 

 

Figure 1-1: SPIDAR system configuration 

SpiView for SPIDAR is PC based software that provides the command and control of the GPR 

network.  SpiView provides a user interface for configuration and control of SPIDAR platforms.  

A platform is defined as a group of GPR units that move in a coordinated fashion with common 

positioning control.  SpiView provides the ability to set up, save and re-call platform 

configurations.  Platform configurations also define the data display and recording information. 
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2 Principles of Operation 

SPIDAR systems uses ground penetrating radar (GPR) technology to image materials such as 

soil, rock, concrete, asphalt etc. GPR systems emit a high frequency radio wave pulse and 

detect the echoes that return from objects within the material. The concept is shown in Figure 

2-1. 

 

Figure 2-1:The Conquest sensor head transmits GPR signals into concrete and collects the signal that reflects from 
rebar, conduits and other targets embedded inside. 

The GPR display shows signal amplitude versus depth (time) and sensor position along a line. 

This is called a “Line Scan”. The echo sounder and fish finder used on boats operate in an 

analogous fashion as indicated in Figure 2-2. 
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Figure 2-2: GPR is conceptually similar to a fish finder. 

2.1 SpiView 

SpiView provides an interface for setting up and controlling data acquisition using a SPIDAR 

system. SpiView communicates with the SPIDAR system via a standard network interface on 

the PC, either Ethernet or WiFi. Projects are used to keep data organized while Platforms are 

used to define the physical setup of the hardware. 

2.2 Projects 

A project defines a workspace in which lines and grids are saved. A project can contain many 

lines and many grids. Projects help by organizing data into logical groups, for example, a project 

may contain all the data collected at a single site. 

2.3 Platforms 

SpiView uses the concept of a platform to define a group of GPR units which move together in 

some coordinated fashion and share the same GPR triggering method. A platform may be 

anything from a single Noggin on a SmartCart to an array of pulseEKKO PRO transducers 

towed behind an ATV. 
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To collect data with a NIC/GPR pair, it must be assigned to a platform. A physical platform 

should be assigned a (0, 0) position and the offset of each GPR on the platform is defined with 

respect to that. 

3 Hardware Configuration 

The network interface on the PC and each NIC must be configured to establish communication 

with one another. 

3.1 SPIDAR Network Interface Controllers (NICs) 

A NIC acts as an interface device between a controlling PC and GPR system. There are two 

types of NICs; the pulseEKKO PRO NICs and Noggin NICs. 

 

Figure 3-1: Noggin NIC (left) and pulseEKKO PRO NIC (right). The main defining feature for each is the GPR port(s) 
on the back of the NIC. 

3.1.1 GPR Port 

Used to connect to a Noggin (37 pin connector on Noggin NIC) or pulseEKKO PRO (dual 15 pin 

connectors on pulseEKKO PRO NICs) based GPR device. 

3.1.2 Odometer Port 

The Odometer port (labeled ODOM) is used to attach an odometer directly to the NIC in single 

channel configurations. When the NIC is part of a multi-channel system using the SPIDAR hub, 

the odometer should be attached to the hub. 

3.1.3 CANBUS Port 

Not implemented. 

3.1.4 Power Port 

12 V DC should be supplied to the NIC through this port in a single channel configuration. When 

the NIC is part of a multi-channel configuration using the SPIDAR hub, power is distributed 
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through the hub and this connection is not necessary. See section 4 for details on powering a 

multi-channel SPIDAR system. 

3.1.5 Network Port 

The Network Port connects the NIC to a PC or to a SPIDAR hub using an Ethernet cable. In 

multi-channel configurations, this port also supplies power, odometer and synchronization signal 

to the NIC. 

3.1.6 Com Port 

The Com port (labeled COMM) is located on the front of the NIC next to the LCD screen. It is 

used for acquiring data from a serial based positioning device such as a GPS. It is also used for 

controlling a pseudo odometer unit (Section 3.3) 

3.1.7 LCD Panel 

The LCD panel on the front of the NIC displays diagnostic information including battery level 

and network status. When power is applied to the unit, the LCD panel will illuminate and display 

the unit’s MAC address, IP address and Host IP address. The characters LNK (Link) and ACT 

(Activity) will appear in the bottom right when the NIC is ready. It is normal for the ACT label to 

flash as the level of network activity varies. 

3.2 SPIDAR Hub  

The SPIDAR hub is used to provide communication, distribute power and synchronize SPIDAR 

NICs. A SPIDAR hub supports up to 4 NICs which can be a combination of Noggin NICs and 

pulseEKKO PRO NICs. Many SPIDAR hubs can be connected together to build larger systems. 

All connections must be made prior to applying power to the SPIDAR hub. 
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Figure 3-2: SPIDAR Hub showing ports 

3.2.1 Link In / PC Port 

This port connects to a PC or to the Link Out port of another SPIDAR hub using an Ethernet 

cable. 

3.2.2 GPR Ports 

The GPR ports are labeled 1 through 4. These 4 ports are used to connect to SPIDAR NICs 

using an Ethernet cable. Since these ports are also supplying power to the NICs, the cables 

should be kept short, around 30 cm. 

3.2.3 Link Out 

The Link Out port Connects to the Link In / PC port of another SPIDAR hub using an Ethernet 

cable. 

3.2.4 Odometer Port 

The Odometer port (labeled ODO) attaches to an odometer unit or a pseudo odometer if free 

run synchronization mode is to be used in SpiView. This odometer signal is then distributed to 

all NICs on the network via the Ethernet connections. If multiple SPIDAR hubs are used, the 

odometer only needs to be attached to the first (master) SPIDAR hub. 

3.2.5 Power Port 

Supplies 12 V DC power to the SPIDAR hub and each NIC attached to the hub. Each SPIDAR 

hub on the network should have its own power supply. See section 4 for details on powering a 

multi-channel SPIDAR system. 
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3.2.6 LCD Panel 

The LCD Panel on the front of the SPIDAR hub displays diagnostic information including the 

battery level and network activity with each of the NICs. When power is applied to the unit, the 

LCD panel will illuminate. The first line of the LCD panel will display “MASTER” when the hub is 

ready. If there is more than one hub on the network, the hub attached to the PC will display 

“MASTER”, the other hubs will display “SLAVE”. 

3.2.7 Com Port 

Not implemented. 

3.3 Pseudo Odometer 

The Pseudo Odometer unit supplies a common clock for all GPR units to trigger from when 

operating in synchronized free run mode (Section 10.3.2.2.1). The yellow cable on the pseudo 

odometer is connected to the odometer port on the SPIDAR hub. The black cable on the 

pseudo odometer is connected to the Com port of one of the SPIDAR NICs. The NIC which the 

pseudo odometer is attached to must be identified in SpiView (Section 10.3.2.2.2). 

 

 

Figure 3-3: Pseudo odometer unit showing connection to a SPIDAR NIC. 

SPIDAR NIC 

Pseudo 

Odometer 

To ODO Port 

on SPIDAR 

Hub 
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4 Powering a Multi-Channel SPIDAR System 

The battery voltage at the input to the SPIDAR hub input must be greater than 11 V and less 

than 14 V to ensure trouble-free operation of the attached GPR devices. Providing a stable, long 

lasting and mobile power source can be a challenge. The following information is provided to 

help design a suitable power distribution method for your SPIDAR system. 

4.1 Estimating SPIDAR Load Current 

Each component in a SPIDAR system will add to the total load current. Knowing the total load 

current will help determine how long a battery will last. The current requirements for each 

component of a SPIDAR system are: 

 IHub = 0.2 A 

INIC = 0.5 A 

 INogginPlus = 0.85 A 

 INoggin Gold = 0.5 A 

 IpulseEKKO PRO = 0.5 A 

Low frequency pulseEKKO PRO transmitters and receivers units have their own batteries so 

they do not contribute to the total current draw through the SPIDAR hub power input. 

To calculate the total load current for your system, simply add up the current for all components. 

For example, if the SPIDAR system has two pulseEKKO PRO units and two Noggin Gold units, 

the total load current would be 

 ITotal = IHub + 2 * (INIC + IpulseEKKO PRO) + 2 * (INIC + INoggin Gold) 

 ITotal = 0.2 + 2 * (0.5 + 0.5) + 2 * (0.4 + 0.5) 

 ITotal = 4.2 A 

For a system with 4 Noggin Plus units, the total load current would be 

 ITotal = IHub + 4 * (INIC + INogginPlus) 

 ITotal = 0.2 + 4 * (0.5 + 0.85) 

 ITotal = 5.6 A 

These total currents should be calculated and accounted for when selecting a power source. 

Batteries have limited capacity which is reduced when the battery is under significant load.  
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4.2 Cabling and Connection Requirements 

At the currents described above the length and quality of the connections and cabling become 

important. Voltage can be reduced at connections or along the length of the power cable. 

Take, for example, the 4 channel Noggin Plus system drawing 5.6 amps. A 4 m long, 18 gauge 

power cable would introduce a drop of 1 V. This means the power source needs to remain 

above 12 V for the system to operate correctly. Since the output voltage of most batteries falls 

as they are used, this voltage drop would decrease the operation time of the system (see 

Battery Capacity below) 

Sensors & Software offers two solutions for powering the SPIDAR system. The standard 

SPIDAR hub power cable allows users to attach the hub to a Sensors & Software power source 

(Figure 4-1). This cable is only recommended systems where the total load current is less than 

3 A. 

 

Figure 4-1: Standard 1 m SPIDAR hub power cable with XLR connectors. 

Also available is a SPIDAR hub power cable with terminal ends (Figure 4-2). This cable allows 

the SPIDAR hub to be attached to any 12 V power source with terminals such as a car battery.  
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Figure 4-2: Standard 3 m SPIDAR hub power cable with terminal and XLR connector ends. 

4.3 Battery Capacity 

As a battery is used, the voltage across its terminals decreases with time. Figure 4-3 shows the 

typical discharge curve for the Sensors & Software 18 Ah power source. The shape of the 

discharge curve depends on the number of amps being drawn.  

 

Figure 4-3: Discharge plot for Sensors & Software’s 18 Ah power source. 

For the example system with two pulseEKKO PRO units and two Noggin Gold units, the battery 

discharge would roughly follow the line labeled 3.6 A (actual load current is 3.8 A). The voltage 

stays above 11 V for approximately 200 minutes. If the voltage drop along the power cable is 
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high, say 1 V, then the system will no longer be able to operate once the battery reaches 12 V, 

in this example approximately 130 minutes, reducing the operating time significantly. 

When designing your own power distribution system keep the following points in mind: 

 Keep the SPIDAR hub as close to the power source as possible. The voltage drop along 
the cable increases as the power cable gets longer. 

 Use a separate power source for each SPIDAR hub. This will increase the operation 
time of the entire system and reduce the load on power cables. 

 If you must use your own wires to connect to the power source, 14 gauge wire (AWG) or 
lower is recommended. 

 Use high quality connections to the power source. Spade or ring terminals are 
recommended. Try to avoid alligator clips as they tend to have high contact resistance 
and are prone to disconnects. Poor connections cause voltage drops which will result in 
SPIDAR system failures.  
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5 PC Configuration 

The network interface on the host PC must be configured to communicate with a SPIDAR 

system. 

5.1 Network Interface 

The network settings for the PC (Windows 7) can be found by navigating to Start > Control 

Panel > Network and Sharing Center. 

 

Figure 5-1: Network and Sharing Center (Windows 7), Change adapter settings option. 

The host PC may have many network connected associated with wired, wireless and Bluetooth 

connections. In most cases the network interface used to communicate with the SPIDAR 

system will be the wired connection and which is name Local Area Connection by default. Right 

click on the network interface select Properties to open the Network Interface Properties dialog. 

Highlight the item labeled Internet Protocol Version 4 (TCP/IPv4) and then click the Properties 

button. 
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Figure 5-2: Network interface properties dialog. 

Check the item “labeled Use the following IP address:”. Set the IP address field to 

192.168.8.120. Set the Subnet mask field to 255.255.255.0. Other IP address may be used, 

whatever IP address is chosen must match the Computer-IP defined on the NICs admin page 

(Section 6.1.7). Click OK to save changes and close the dialog. 
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Figure 5-3: Internet Protocol Properties dialog. 

Close all remaining dialogs and windows. 

5.2 Firewall 

It is recommended that the Windows firewall be disabled when using SPIDAR. The firewall can 

cause delays in the network communication. To access the firewall settings, navigate to Start > 

Control Panel > Windows Firewall. Select the option to “Turn Windows Firewall On or Off” 

 

Figure 5-4: Windows Firewall (Windows 7), Turn Windows Firewall on or off option. 
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The PC may have many firewalls for each type of network. It is advised that the firewall be 

turned off for Home and Public network types, but be left on for Domain network types (if any). 

The SPIDAR network will normally be set up as a Public network type. Click OK to save settings 

and close the window. 

 

Figure 5-5: Windows Firewall Customize Settings window. 

Close any remaining windows. 
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6 NIC Administration Page 

Each NIC has an administration web page that can be accessed by typing the NIC’s IP address 

into a standard web browser. The IP address of the NIC is displayed on its LCD screen on boot-

up. 

 

Figure 6-1: NIC admin home page 

Click on the Admin Page button to view and edit the NIC’s settings. 
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Figure 6-2: NIC settings page 

6.1 Admin Page 

6.1.1 GPR Type 

This indicates the type of GPR device to be controlled by the NIC. The options include Noggin 

Plus, Noggin Gold and pulseEKKO PRO. pulseEKKO PRO should only be selected when using 

a pulseEKKO PRO NIC. 

6.1.2 NIC Name 

This is a user editable name given to identify the NIC. The name must be unique on the 

network. It is common to use a numbering scheme to identify the NICs when many are to be 

used on the same platform. 

6.1.3 NIC SN 

This is the serial number of the NIC. This field is for information purposes only and is not 

editable. 
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6.1.4 MAC Address 

The Media Access Control (MAC) address uniquely identifies the network interface hardware in 

the NIC. This field is for information purposes only and is not editable. No two NICs on the same 

network should have the same MAC address. 

6.1.5 NIC IP-Address 

The Internet Protocol (IP) address defines the address for communicating with the NIC over a 

network. The IP address is user editable and must be unique for all NICs on the network. It is 

common that a numbering scheme be used to help identify the NICs when many are to be used 

on a single platform. 

6.1.6 Subnet Mask 

The Subnet Mask defines the range of addresses which can communicate with this NIC. 

Typically this is set to 255.255.255.0 meaning that the first three fields in the IP addresses of all 

devices on the network must be the same. This must be the same for all NICs and the host PC 

on the network. 

6.1.7 Computer IP-Address 

The Internet Protocol (IP) address of the computer which will be used to control this NIC. This 

must be the same for all NICs to be used on the same platform. It must also match the IP 

address configured on the host PC’s network interface. 

6.1.8 Port 

The Port number to use to establish initial communication with the PC. This must be the same 

for all NICs to be used on the same platform. It is typically set to 1213 and must match the 

setting in SpiView Preferences (Section 9.1.2). 

6.1.9 Reset to Default 

This button will reset all settings on this page to their defaults values. 

6.2 Firmware 

Indicates the version of firmware installed on this NIC. 
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Figure 6-3: NIC Firmware page 

6.2.1 NIC Firmware 

Indicates the version of firmware installed on this NIC. NIC firmware is updated using the NIC 

Update software. Please contact Sensors & Software for information about NIC firmware 

updates. 

6.2.2 GPR Firmware 

Indicates the version of firmware installed on the GPR unit. Please contact Sensors & Software 

for information about GPR firmware updates. 
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7 Getting Stared 

The dynamic nature of SPIDAR systems can result in complex configurations. This section is 

intended to be the first step in getting users comfortable with how to work with SPIDAR 

systems.  A SPIDAR system has to be viewed as 3 distinct parts; the physical component 

distribution, the hardware component interconnections (power, communications, triggering), and 

overall command and control which is Windows based PC program called SpiView for SPIDAR. 

To make the introduction to SPIDAR as easy as possible, the following procedure will take the 

user through the set up and operation of a complete SPIDAR system.  Once the user starts to 

gain familiarity they can start to develop a unique workflow that will best suit their specific 

application.   

7.1 Quick Start Procedure 

The following procedure will guide users through the complete setup and operation of a SPIDAR 

system using a single NIC and GPR system. 

7.1.1 System Configuration 

1. Review section 3, section 4 and section 6 to ensure that the network interfaces are 
properly configured. 

2. Connect a GPR system (Noggin or pulseEKKO PRO) to a NIC using the appropriate 
GPR cables. 

3. Connect the NIC to the PC with an Ethernet cable and apply 12V power to the NIC. 
 

7.1.2 Software Setup 

1. Install the SpiView for SPIDAR software onto the PC connected to the NIC. 
 

7.1.3 Starting a Project 

1. Run SpiView by double clicking the SpiView for SPIDAR icon on the desktop. 
2. A Getting Started dialog will be presented. All data collected must be saved as part of a 

project. Set the desired name for the project under the heading “Create a New Project”. 
Then click the Create Project button. 
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Figure 7-1: Getting Started dialog presented when SpiView is first started. 

7.1.4 Creating a Platform 

1. Select File > Platform > New… to open the Platform Settings dialog. Name the platform 
and select the desired units. 

 

 
Figure 7-2: Platform Settings dialog, General tab 

 
2. Click on the NICs tab and wait for the attached NIC to appear in the “Unassigned NICs” 

list. If it does not appear shortly, check all connections and ensure the NIC is properly 
powered. 
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Figure 7-3: Platform Settings dialog, NICs tab showing a NIC detected in the Unassigned list. 

 

3. Select the NIC on the “Unassigned NICs” list and click the  button to move it to the 
“Assigned NICs” list. 

 
Figure 7-4: Platform Settings dialog, NICs tab showing a NIC moved to the Assigned list. 

 
4. Click on the Acquisition tab, set the Trigger Method to Free Run 
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Figure 7-5: Platform Settings dialog, Acquisition tab 

5. Ensure that the Auto Detect GPR Settings button at the bottom of the dialog is turned 
on, and click OK. SpiView will create a new platform and auto detects the GPR unit 
attached to the NIC. The suggested GPR settings will be automatically applied. 

7.1.5 Collecting Data 

1. Click the Collect Data  button from the Platform toolbar. 
2. Click the Collect Data Without Saving option 
3. Wait for the GPR to initialize 

4. Click the Start Acquisition  to start acquiring data. 

5. Click the Stop Acquisition  to stop acquiring data. 
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8 SpiView Interface 

The SpiView interface is comprised of 5 main elements: 

1. NIC manager 

2. Main toolbar 

3. Platform toolbar 

4. Single trace display 

5. Cross-section display 

 

Figure 8-1: SpiView main interface 

8.1 NIC Manager 

The NIC Manager is used to access each part of a platform including the NICs, GPR devices 

and GPS devices. Clicking any item in the NIC Manager will provide a list of options associated 

with that item. For example, clicking on one of the GPR device items will present access to the 

GPR settings for that unit. 

Clicking in the blank area inside the NIC Manager displays options related to creating, opening 

saving and closing Projects and Platforms. 

Cross-section display 

Main toolbar Platform toolbar 

NIC Manager 

Single trace display 
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Figure 8-2: NIC Manager right-click menu 

The NIC Manager can be hidden to increase the amount of screen space used for displaying 

data. To show or hide the NIC Manager click View > NIC Manager, or press CTRL+M. 

The items displayed in the NIC Manager are described in detail below. 

8.1.1 Unassigned 

The Unassigned  item is only displayed if NICs have been detected by SpiView but have 

not yet been assigned to a platform. Expand this item to see a list of NICs which have yet to be 

assigned to a platform. 

8.1.2 Platform 

The Platform   item is displayed if a platform has already been created. Expand this item 

to list all of the NICs assigned to this platform. 

Clicking on the platform item will allow access to the Platform Settings or the View All Settings 

menu. The operator also has the option to Export the platform to a file or Close the platform. 

8.1.3 NIC 

The NIC  item can be a sub-item of either Unassigned or Platform. If a NIC is unassigned, 

it must be assigned to a platform before it can be used to acquire GPR or GPS data. See the 

Platform Settings dialog (Section 10.2) for instructions on assigning a NIC to a platform. 

If a NIC is assigned to a platform, expanding this item will allow access to the GPR device and 

GPS device associated with this unit. 

Clicking on the NIC item will allow access to the Show Info menu and the ability to launch the 

admin page for the NIC using an installed web browser. NOTE: Editing information on the NIC 

admin page will cause the unit to reboot. SpiView must be restarted in order to begin 

communicating with the NIC device again.  
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8.1.4 GPR Device  

The GPR Device  item will be a sub-item of a NIC which is assigned to a platform. Clicking 

on this item will allow access to the GPR Settings and the Scope menu. 

8.1.5 GPS Device 

The GPS Device  item will be a sub-item of a NIC which is assigned to a platform. Clicking 

on this item will allow access to the GPS Settings menu. 

8.2 Main Toolbar 

The main toolbar provides access to a variety of SpiView program and display options. The 

location of this toolbar can be changed by dragging the handle on the left edge of the toolbar. 

Buttons on the main toolbar may become inactive when SpiView is performing certain 

operations, such as initializing the GPR units. 

 

Figure 8-3: SpiView Main toolbar 

8.2.1 Save Project  

The Save Project  button will save the current project. If the project has never been saved 

before, SpiView will ask for a location to save it in. If the project was opened from an existing 

project or has been saved previously, this button will automatically save over the previous copy. 

If the system is set in Legacy Data Mode (Section 9.2.4) this button will not be visible since data 

is saved in real-time. 

8.2.2 Preferences 

The Preferences  button provides access to the SpiView preferences menu. Preferences 

pertain to settings saved with the program itself, not individual platforms. See section 9 for 

details on the Preferences menu. 
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8.2.3 Full Screen 

The Full Screen  button maximizes the SpiView application window and hides items on the 

screen not required during data acquisition. Pressing the Full Screen button again restores the 

window to its original state. 

8.2.4 Arrange Views 

The Arrange Views button is used to automatically arrange single trace and cross-section 

display windows in the space available. The options include All Single Traces, All Cross-

Sections and All Windows. The default mode, All Windows, is used when a new platform is 

created. 

8.2.5 View Settings 

The View Settings  button opens the View Settings dialog for the currently active cross-

section or single trace display. 

8.3 Platform Toolbar 

The platform toolbar provides access to the control functions for the platform. The platform 

toolbar is only visible once a platform has been created. The location of this toolbar can be 

changed by dragging the handle on the left edge of the toolbar. Buttons on the platform toolbar 

may become inactive when SpiView is performing certain operations, such as initializing the 

GPR units. 

 

Figure 8-4: Platform toolbar 

8.3.1 Platform Name 

The name of the platform is displayed on the toolbar. Clicking on the platform name displays 

options for Platform Settings or the View All Settings menu. The operator also has the option to 

Export the platform to a file or Close the platform. 
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8.3.2 Collect Data 

The Collect Data  button is used to start a new line scan or grid scan. The user may also 

choose to collect a line without saving.  

8.3.3 Start Acquisition 

The Start Acquisition  button is used to start data collection once the GPR has been 

initialized. 

8.3.4 Pause Acquisition 

The Pause Acquisition  button is used to temporarily suspend data collection when in Free-

Run mode. When the system is paused, this button be become inactive; click the Start 

Acquisition button to resume data collection or the Stop Acquisition button to end the current 

line. 

This button is not available in Odometer or Manual Trigger mode. 

8.3.5 Trigger 

The Trigger  button replaces the Pause Acquisition button when running in Manual Trigger 

mode. Clicking this button will collect a single GPR trace from each GPR device on the platform, 

and then wait. 

8.3.6 Stop Acquisition 

The Stop Acquisition  button is used to stop data collection and end the current line. 

8.3.7 Fiducial 

The Fiducial  button can be used to mark items of interest on a GPR line. Fiducials are 

saved in the data for each GPR line and are sequentially numbered starting at 1 for each new 

line. The number of the last fiducial added will appear within the icon as they are marked. 
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Figure 8-5: Fiducials appear as red triangles at the bottom of the cross-section display. 

8.4 Single Trace Display 

During data collection, the Single Trace display window shows the trace associated with the 

current position of the GPR device. The raw trace data is displayed in a scope like display with 

time (ns) or depth along the vertical axis and amplitude (mV) across the horizontal axis. The 

range of each axis can be set independently in the View Settings menu. 

 

Figure 8-6: Single trace display 

The window’s status bar displays the number of the trace currently being displayed (Trc#) and 

the total number of skipped traces (Skp:) encountered since the line was started. If the currently 

displayed trace is a skipped trace, it will appear red; otherwise it will be drawn green. 

Clicking anywhere on the single trace display will provide options for accessing the view settings 

or closing the window. 

8.5 Cross-Section Display 

During data collection, the Cross-section display window shows the GPR data as a color map 

image. Time (ns) or depth is plotted along the vertical axis and position across the horizontal 

axis. The range of each axis can be set independently in the View Settings menu. 
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Figure 8-7: Cross-section display 

The window’s status bar displays the current position (Pos:), trace number (Trc#:) and the total 

number of skipped traces (Skp:) encountered since the line was started.  

When backing up, a red vertical line appears on the screen to indicate the current position of the 

GPR device. The trace number and position in the status bar will update accordingly. 

Skipped traces appear at the bottom of the cross-section as red rectangles. Fiducials appear at 

the bottom of the cross-section as red triangles labeled F1, F2, F3, etc… 

When the Stacking Type for the GPR device is set to DynaQ, the DynaQ status bar will be 

plotted along the bottom of the cross-section. The color of the DynaQ status bar represents the 

quality of the collected data, based on number of stacks; 

 Dark blue: High quality GPR data 

Light blue: Normal quality GPR data 

Yellow: Below normal quality GPR data 

White: No data (traces skipped) 

Position scale 

Backup arrow 

Fiducial tag 

Depth / Time 

Scale 

Skipped trace tag 

DynaQ bar 
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Clicking anywhere on the cross-section display will provide options for accessing the view 

settings, the gain/filter settings or closing the window. 
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9 Preferences 

The Preferences menu contains settings common to the SpiView application rather than a 

particular platform.  

The Enable on-screen keypad button enables the use of a numeric keypad when certain fields 

are selected. This option is useful when operating on a touchscreen device without a keyboard. 

9.1 Network Tab 

The network tab contains settings specific to the network interface on the host PC which is used 

to communicate with the NICs. 

 

Figure 9-1: Preferences menu, Network tab. 

9.1.1 IP Address 

This is the IP address of the network interface which will be used to communicate with the NICs. 

The default value is set to Automatic, which means that SpiView will try to detect NICs on all 

available network interfaces. When a NIC is detected, this becomes the primary interface on 

which to look for additional NICs.  

To specify a particular network interface, select it from the dropdown list. If the desired IP 

address does not appear on the list try clicking the Refresh button. Also note that some 

Windows systems will not show the IP address in the list until the Ethernet cable is plugged in 

and there is a powered network device on the other end. If this value is set manually, it must 

match the Computer IP-Address value specified on the NICs admin page, see section 6.1.7 for 

details. 
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9.1.2 Server Port 

The server port is used to initialize communication with the NICs. This value must match the 

value specified on the NICs admin page, see section 6.1.8 for details. The default value is 1213. 

9.1.3 Retry Count 

The Retry Count specifies the number of tries to connect to a NIC when loading a Platform. If a 

NIC does not respond after this number of tries, then an error will be displayed with the option of 

trying again. Loading larger platforms may take longer than smaller ones. 

9.2 Projects Tab 

The Projects tab specifies the default location for saving and loading projects, as well as startup 

related options. 

 

Figure 9-2: Preferences menu, Projects tab 

9.2.1 Working Directory 

This specifies the path to use as the default location for saving and loading projects and 

platforms. The default location is the My Documents folder for the user who is currently logged 

into the computer. 

9.2.2 Show Welcome Screen on Startup 

When this option is enabled, the welcome screen will be displayed whenever SpiView is started. 

The welcome screen guides users into creating a new project or opening an existing one. See 

section 17 for details. 
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9.2.3 Load Last Platform on Startup 

When this option is enabled, the platform being used when SpiView was last closed will be 

loaded after a project has been created or opened. This option is designed for operators who 

mainly use one platform.  

9.2.4 Legacy Data Mode 

Legacy Data Mode will write all data directly to a user specified folder in real-time rather than 

saving to a Project (GPZ) file. Use this mode if large quantities of data are expected to be 

collected in a single session. When this mode is enabled, the Save icon will not be visible on the 

main toolbar. 

9.2.5 File Number Digits 

The number of digits to pad the automatic file numbers with. For example, when set to 2, the 

automatic file numbering will generate files 01, 02, 03, etc… Lines which are part of a grid do 

not use this parameter as the number of digits is based on the number of lines specified in the 

grid. 

9.3 Acquisition Tab 

The Acquisition tab specifies options used during data collection. 

 

Figure 9-3: Preferences menu, Acquisition tab 

9.3.1 Pre-time (%) 

The Pre-time is the portion of the time window reserved for data collected before the first arrival 

event is received. When a GPR device is automatically scoped, the pulse will be shifted so that 
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the first arrival occurs at this percentage of the time window. This acts as a guideline and the 

pulse can be placed anywhere by manually shifting it in scope mode. 

 

Figure 9-4: Scope mode showing the pre-time line in red at 10% of the window. 

9.3.2 Set zero time to first break if GPR is bi-static 

When this option is enabled, SpiView will attempt to detect the first break point for bi-static GPR 

devices (such as low frequency pulseEKKO PRO) for each line. In some situations where the 

direct wave amplitude is weak, SpiView may not be able to accurately pick the first break point. 

In these situations, it may be advantageous to disable this feature in which case, SpiView will 

place zero time at the value specified in the Pre-time % field. 

9.3.3 Enable audio feedback 

During acquisition certain button will cause sound effects to play to confirm the function was 

performed.  

9.3.4 Show message on manual trace trigger 

When the platform is set to manual trigger mode, a message will be displayed on the cross-

section each time a trace is requested by the operator. 

10 Platform Settings 

The Platform Settings menu is used to configure various options related to the platform. 
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Figure 10-1: The Platform Settings menu 

The Auto Detect GPR Settings button at the bottom will only be available when creating a new 

platform. If this option is turned on, SpiView will attempt to detect the GPR device connected to 

each NIC. Any GPR device recognized will have a set of default settings applied. It is highly 

recommended to leave this option turned on when creating a new platform. 

10.1 General Tab 

10.1.1 Name 

This name will identify the platform in various menus throughout SpiView. This name will also be 

the default file name when the platform is saved to a project or exported. 

10.1.2 Description 

A more detailed description of the platform entered by the user. 

10.1.3 Units 

The option of collected data in Metric (m) or US Standard (ft) 
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10.2 NICs Tab 

10.2.1 Unassigned NICs 

This list will display any NICs that have been detected on the network but have not yet been 

assigned to a platform. While SpiView is searching for available NICs, the text “Detecting…” will 

be displayed in the box. 

 

Figure 10-2: Platform Settings menu, NICs tab while searching the network for available NICs. 
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Figure 10-3: Platform Settings menu, NICs tab while searching the network for available NICs. 

 

10.2.2 Assigned NICs 

This list will display any NICs that have been assigned to this platform. Once a NIC is assigned 

to the platform it will inherit the units and triggering method of the platform. 

10.2.3 Assign and Unassign  

The Assign  and Unassign  buttons are used to move NICs between the Unassigned 

and Assigned list. A group of NICs can be moved all at once by highlighting them all and 

clicking the corresponding button. 

10.3 Acquisition Tab 

 

Figure 10-4: Platform Settings menu, Acquisition tab. 

10.3.1 Survey Type 

The Survey Type defines the survey mode to collect data in. The options are Reflection and 

WARR/CMP. A reflection survey is the most common type of GPR survey, where the transmitter 

and receiver are kept at a fixed distance from each other. A reflection survey can be performed 

with many GPR devices on the platform. A Wide Angle Reflection Refraction / Common Mid-

Point (WARR/CMP) survey is performed by changing the offset between the transmitter and 
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receiver by a standard amount between each trace. The WARR/CMP survey can only be 

performed with one GPR on the platform. 

10.3.2 Trigger Method 

The Trigger Method defines how and when traces are collected. GPR data can be acquired in 

Manual mode, Free Run mode or Odometer mode. 

10.3.2.1 Manual 

When the platform triggering method is set to Manual mode, traces will only be collected when 

requested by the operator by pushing the Trigger button. Each time the trigger is pressed, a 

trace will be collected by every GPR device on the Platform simultaneously. 

Manual mode is often used in very rough terrain when the GPR must be moved to a specific 

location without the aid of an odometer. It is also commonly used for performing WARR/CMP 

surveys. 

10.3.2.2 Free Run 

In Free Run mode, GPR data are acquired at a specified time interval. This interval (in seconds) 

can be specified individually for each GPR device via the GPR settings menu. Since GPR data 

acquisition is controlled by each NICs internal clock, there may be slight differences in the time 

at which each trace is collected across multiple NICs. 

10.3.2.2.1 Synchronize Free Run 

The Synchonize Free Run mode uses a specialized piece of hardware called a Pseudo 

Odometer to act as a common external trigger. Using a common clock allows the trace counts 

of all GPR devices on the platform to be kept in sync. 

10.3.2.2.2 Pseudo Odometer Control 

When the Synchonize Free Run mode is active, the Psuedo Odometer Control NIC must be 

defined. This NIC is used to start and stop the pseudo odometer when the operator requests the 

line to start or stop. 
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Figure 10-5: Pseudo odometer hardware configuration 

10.3.2.3 Odometer 

In Odometer mode, GPR data are acquired at a specified spatial interval. An odometer must be 

attached to the SPIDAR system for this mode to work. This interval can be specified individually 

for each GPR device via the GPR settings menu.  

If running a single channel system, the odometer must be connected to the NIC or to the Noggin 

cable or pulseEKKO PRO transducer cable.  

If running a multi-channel system, it must be connected to the odometer input port on the 

master SPIDAR hub (if running a multi-channel system). The odometer sends triggers to each 

NIC simultaneously so traces are kept in sync. 

10.3.2.3.1 Calibration 

In order for the odometer to accurately keep track of distance travelled, it must be calibrated for 

the ground surface which is being surveyed. This calibration coefficient is always displayed in 

ticks per meter.  

If the calibration coefficient is known for a particular platform and ground material it can be 

entered manually into the Calibration field. Otherwise click on the Calibrate Odometer button to 

enter the calibration mode. The odometer calibration process is described in section 15. 
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10.3.2.3.2 Odometer Direction 

The direction of the odometer can be set to either Forward or Reverse. This value defines the 

direction of spin which causes the GPR to trigger. For a standard SmartCart, forward indicates 

pushing the cart and reverse indicates pulling it. For custom platform configurations, the 

direction of the odometer will depend on how the odometer unit is installed. 

10.3.2.3.3 Enable Multi Channel Synchronization (MCS) 

Multi-channel synchronization is a mode which staggers the GPR data acquisition between 

multiple units so that they do not interfere with one another. This mode can only be used for 

multi-channel systems using a SPIDAR hub. Enabling MCS will not impact the data collection 

speed of the system, regardless of the number of channels used. 

MCS will eliminate cross-channel interference for systems up to 8 channels. Systems with more 

than 8 channels may experience some interference if the GPR units are placed very close 

together. However this is usually not physically possible with such a large system. 

10.4 GPR Offsets 

10.4.1 GPR Offset Table 

The position of each GPR on the platform must be defined so that relative offsets can be 

applied to the data from each channel. To change an X or Y position for a GPR device, click on 

the corresponding field in the table. It is up to the operator to choose an origin (0,0) for the 

platform. The origin can be located anywhere on (or even off) the platform, such as one of the 

GPR units, or a point on the cart such as a wheel. It is important to note that the point chosen as 

the platform origin must be used at the starting point for all lines collected with the platform to 

ensure accurate positioning on the GPR lines. 
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Figure 10-6: Platform Settings, GPR Offsets tab. In this example the GPR attached to NIC2 is 57 cm behind the GPR 
attached to NIC1.Any line collected with this platform should start with the GPR attached NIC1 centered on the start 

position. 

 

Figure 10-7: Example 7 channel platform with 7 GPR units, in two rows. Each channel collects a line 10 cm away 
from the one beside it. 
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Figure 10-8: Platform Settings, GPR Offsets tab. In this example the 7 GPR units are each spaced 10 cm apart, in 
two rows separated by 40 cm.  

 

10.4.2 Apply Offsets to Cross-section Views 

When this option is turned on, SpiView will insert blank space at the end of the cross-section 

display so that positions line up between the channels. It is recommended that this option be left 

on during normal operation. One reason the operator might turn this feature off is in case the 

separation between the GPR devices is large enough that both do not fit well on one screen. 
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Figure 10-9: Cross section displays with GPR offsets applied. Blank space is added to the end of the cross-section of 
NIC2 so that the position scales align. 

 

Figure 10-10: Cross section displays without GPR offsets applied. No blank space is added to the end of the cross-
section; position scales do not align. 
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11 GPR Settings 

The GPR Settings menu contains all of the parameters required for setting up a GPR device. 

This menu can be accessed by clicking on the GPR Device in the NIC Manager (Section 8.1.4) 

or from the View All Settings menu (Section 13).  

The Set Defaults button will set all of the default settings in all of the tabs for the selected Family 

and Frequency of GPR device. 

11.1 System Tab 

The System tab defines the type and frequency of GPR being used. 

 

Figure 11-1: GPR Settings menu, System tab 

11.1.1 Family 

The Family defines the type of GPR being used. The options include Noggin, Conquest, 

pulseEKKO PRO and pulseEKKO PRO TR. After a Family is selected, the list of available 

Frequencies will update. This item will only be available if the GPR has not yet been detected. 

11.1.2 Frequency 

The Frequency defines the center frequency of the GPR being used. The frequencies available 

in the list will be limited by the Family chosen above. This item will only be available if the GPR 

has not yet been detected. 

11.1.3 Antenna Sep. 

This value indicates the separation between the transmitting and receiving antenna. If the GPR 

defined by the family and frequency has fixed antennas, then the Antenna Separation will be 
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automatically filled in. Some GPR devices, such as the pulseEKKO PRO 1000, allow the 

transmitter and receiver to be separated. For these devices, a default Antenna Separation will 

be applied but it may be altered by the user. This item will only be available if the GPR has not 

yet been detected or the unit does not have a fixed antenna separation. 

11.1.4 Auto Detect 

This Auto Detect button will attempt to read the family, frequency and antenna separation from 

the GPR device. The GPR device must be attached for this operation to work. This button will 

not be available if the GPR has been previously detected. When creating a new platform, the 

user has the option of auto detecting the GPR devices (see section 10). 

11.2 Window Tab 

The Window tab defines all the settings associated with the GPR time window.  

 

Figure 11-2: GPR Settings menu, Window tab 

11.2.1 Depth / Time 

The operator can set the Depth or Time (in nanoseconds) for which the GPR is recording data. 

Setting either the Depth or the Time will change the other value based on the Velocity field. To 

set a field, click the corresponding button next to the value, this will allow that value to be 

changed. If using the Depth option, it is recommended that the Velocity field be updated first to 

a best estimate for the ground material being surveyed. 

11.2.2 Velocity 

The velocity defines the estimated velocity at which the radar pulse travels through the 

subsurface. This velocity is used to calculate a Depth from a Time or vice-versa.  
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11.2.3 Time Sampling Interval 

This is the time between sample points on the collected trace in picoseconds. It is highly 

recommended to use the default setting for the set frequency. Setting this value too high may 

result in low quality data. Setting this value too low may severely limit the data collection rate. 

 

Figure 11-3: Example trace showing discrete sample points used to recreate the waveform. The time between each 
point is known as the time sampling interval and is constant along the trace. 

11.2.4 Window Time Shift 

The Window Time Shift defines where the transmit pulse appears in the receiver’s recording 

window. It is highly recommended that this value be set by using the Scope Mode function for 

the GPR device (Section 15). 

11.3 Positioning Tab 

The Positioning tab is used to define the distance or time between traces. 

Time Sampling Interval 
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Figure 11-4: GPR Settings menu, Positioning tab 

11.3.1 Step Size 

The Step Size defines the distance between traces. In odometer mode, this distance is 

measured by the odometer before the next trace is acquired. In free-run or manual mode, the 

accurate positioning of the GPR unit is left to the operator, but the step size is still used to 

compute the position of each trace. 

 

Figure 11-5: Example GPR data showing individual traces. The distance between each trace is known as the step 
size and is constant along the line. 
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11.3.2 Trace Interval 

The Trace Interval is only available when operating in free-run mode. This defines the time 

between each trace in seconds. In free-run mode, the position of each trace is still calculated 

based on the trace number and the step size. 

11.4 Stacking Tab 

Stacking is used to increase the signal to noise ratio of the GPR data by collecting a point many 

times and taking the average value. 

 

Figure 11-6: GPR Settings menu, Stacking tab 

11.4.1 Stacking Type 

The Stacking Type can be set to either Fixed or DynaQ. In Fixed stacking mode, the number of 

primary and secondary stacks is defined ahead of time. If the GPR device does not have 

enough time to collect all of the requested stacks then a trace is skipped.  

In DynaQ mode, the GPR device will collect as many stacks as it has time for before the next 

trace is requested. This means that the number of stacks will vary from trace to trace depending 

on how quickly the platform is moving. DynaQ stacking can only be enabled in odometer mode. 

Since DynaQ is a processor intensive process, GPS data cannot be collected on a NIC which 

has DynaQ enabled. 

11.4.2 Primary Stacks 

Primary stacking is performed in the GPR receiver by stacking each sample point before moving 

on to the next. 
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11.4.3 Secondary Stacks 

Secondary stacking is performed in the NIC and is done by stacking each trace before moving 

on to the next. 

 

12 GPS Settings 

The GPS Settings menu contains all of the parameters required for setting up a GPS device. 

This menu can be accessed by clicking on the GPS Device in the NIC Manager (Section 8.1.5) 

or from the View All Settings menu (Section 13).  

 

Figure 12-1: GPR Settings menu, Stacking tab 

12.1 Enable GPS Device 

To view and save GPS data, the GPS device must be enabled by turning on this button. If 

DynaQ is enabled on the GPR device you will not be allowed to enable the GPS. Set the 

Stacking Type to Fixed in the GPR Settings (Section 11.4.1) before enabling the GPS device. 

12.2 Baud Rate 

The Baud Rate is the speed at which the serial port operates. This value is unique to the GPS 

unit. Please consult the manual for your GPS device to determine this value. If the baud rate is 

set incorrectly no data will be received by the NIC.  

Since there is a limited list of supported baud rates, if the GPS baud rate is unknown it is easy 

to try each one in the list. Simply set the baud rate using the drop down list and click the Test 

button. If no data is received then exit the test menu and try a different baud rate. If none of the 

baud rates work, this may indicate a problem with the GPS, power supply, or cable. 
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12.3 End String 

The End String is the last string in the sequence of NMEA strings received from the GPS 

device. This is used to define the end of a GPS data packet. The end string is unique to the 

GPS device. If the End String is set incorrectly, NIC will continue to receive data from the GPS 

but it may not be saved correctly. 

After running the GPS test, the drop down will be automatically filled with all strings received by 

the GPS device. 

12.4 Test 

The Test button will open the GPS Test menu. When the test menu is closed, SpiView may 

suggest an End String based on information it received from the GPS device. 

12.4.1 Status Tab 

The Status tab displays status information such as signal quality, number of satellites and the 

current latitude and longitude. If the status is “GPS Disconnected”, check all GPS connections 

and the power source. If the status is “No Signal”, data are being received but no satellites are 

in view, move to a more open location. 

 

Figure 12-2: GPS Test menu; Status tab. 

 

12.4.2 Strings Tab 

The Strings tab displays raw NMEA strings. This view can be used to determine the End String 

and ensure the correct strings are being received. 
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Figure 12-3: GPS Test menu; Strings tab. 

GPS data are sent in groups of strings. In order to save GPS data, the software needs to know 

the prefix of the last NMEA string being sent in each group. In the example data in Figure 12-3, 

the last string in the group is prefixed by $GPVTG. To determine the End String, monitor the 

Strings tab of the GPS Test menu and record the prefix of the string on which the data seems to 

pause momentarily. 

This technique will be more difficult for GPS systems with higher update rates. In these cases 

you may need to consult with the GPS manufacturers’ user guide. 
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13 View All Settings 

The View All Settings menu can be accessed by clicking the platform item in the NIC manager 

(Section 8.1.2) or by clicking the name of the platform in the Platform Toolbar (Section 8.3.1).  

 

Figure 13-1: View All Settings menu 

13.1 Platform Settings 

A summary of the platform settings are displayed at the top of the window. The platform settings 

group lists the current survey type, trigger mode, multi-channel synchronization status and units. 

If the platform is set to odometer mode, the odometer calibration and odometer direction will 

also be displayed. Click the Edit Platform button to open the Platform Settings menu (Section 

10). 

13.2 NIC Settings 

The NIC Settings table displays a list of all the GPR and GPS settings associated with each 

NIC. The NIC name is listed across the top of the table, and the setting name is listed along the 

left side. The GPR and GPS settings are broken into sections to match the tabs in the GPR 

Settings menu (Section 11).  
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To change a particular GPR setting, click on that cell within the table and click the Edit GPR 

Settings menu option. 

 

Figure 13-2: View Settings menu, Single Trace tab 

Clicking the Edit GPR Settings option will open the GPR Settings menu for that GPR device. 

While the GPR Setting menu is open the operator can change any other settings as well. When 

the GPR Settings menu is closed, the table will update. 

The Apply to All option will apply the currently highlighted setting to all GPR devices on the 

platform. This feature is useful, for example, for setting up a platform with all the same GPR 

frequency or to set all systems to use the same number of stacks. 

To change a particular GPS setting, click on that cell within the table and select the Edit GPS 

Settings option. Similarly this will open the GPS Settings menu for that device. 

 

14 View Settings 

The View Settings menu can be accessed by clicking anywhere on a cross-section or single 

trace display and choosing View Settings or from View > Settings on the SpiView main menu.  

14.1 Single Trace Tab 

The Single Trace tab contains options for changing the single trace display. 
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Figure 14-1: View Settings menu, Single Trace tab 

14.1.1 Depth Scale 

The Depth Scale is plotted vertically in the single trace display, it can be enabled or disabled by 

toggling this button. 

14.1.2 Depth Scale - Show Grid Lines 

The horizontal grid lines can be enabled or disabled by toggling this button. 

14.1.3 Link View Range to Cross-section 

When this feature is enabled the depth / time range will be locked to match the cross-section 

display. It is recommended to leave this feature enabled so that responses in the single trace 

align vertically with the same response in the cross-section. 

14.1.4 Depth / Time 

This feature allows the scale to be displayed in either Depth or Time (ns). 

14.1.5 Show Pre-time 

When this feature is enabled, the data collected before the first arrival of the transmit pulse will 

be displayed. This is useful for monitoring background noise levels. 
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14.1.6 Display 

The Display sets the maximum range, in time or depth, that is viewed within the Single Trace 

display. 

14.1.7 Auto 

When this feature is enabled, the Display range will be set the same as the recording window 

defined in the GPR Settings. If the recording window is changed between lines, the Single Trace 

Display range will automatically update. 

14.1.8 Amplitude Scale 

The Amplitude Scale is plotted horizontally across the single trace display, it can be enabled or 

disabled by toggling this button. 

14.1.9 Amplitude Scale – Show Grid Lines 

The vertical grid lines can be enabled or disabled by toggling this button. 

14.1.10 Range 

This parameter defines the amplitude range that is displayed across the single trace display. 

The range extends from negative to positive. For example, if the Range is set to 50 mV, the 

scale will extend from -50 mV to +50 mV. 

14.1.11 Apply to All Single Trace Displays 

If this feature is active, all of the settings in this tab will be applied to all single trace display 

windows. 

14.2 Cross-section Tab 

The Cross-section tab contains options for changing the cross-section display. 
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Figure 14-2: View Settings menu, Cross-section tab 

14.2.1 Depth Scale 

The Depth Scale is plotted vertically in the cross-section display; it can be enabled or disabled 

by toggling this button. 

14.2.2 Depth Scale - Show Grid Lines 

The horizontal grid lines can be enabled or disabled by toggling this button. 

14.2.3 Line View Range to Single Trace 

When this feature is enabled the depth / time range in the single trace display will be locked to 

match the cross-section display. It is recommended to leave this feature enabled so that 

responses in the single trace align vertically with the same response in the cross-section. 

14.2.4 Depth / Time 

This feature allows the vertical scale to be displayed in either Depth or Time (ns). When set to 

depth, the units are set in the Platform Settings (Section 10.1.3). 

14.2.5 Show Pre-time 

When this feature is enabled, the data collected before the first arrival of the transmit pulse will 

be displayed. This is useful for monitoring background noise levels. 
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14.2.6 Display 

The Display sets the horizontal range that is viewed within the Cross-section display. 

14.2.7 Auto 

When this feature is enabled, the Display range will be set the same as the recording window 

defined in the GPR Settings. If the recording window is changed between lines, the Cross-

section Display range will automatically update. 

14.2.8 Position Scale 

The Position Scale is plotted horizontally across the cross-section display; it can be enabled or 

disabled by toggling this button. 

14.2.9 Postion Scale – Show Grid Lines 

The vertical grid lines can be enabled or disabled by toggling this button. 

14.2.10 Display 

This parameter defines the position range that is displayed across the cross-section window. 

The newest data is always displayed at the right of the cross-section and extends back by the 

defined amount. 

14.2.11 Color Palette 

The Color Palette defines how positive and negative GPR signals are translated into colors for 

the cross-section display. Some color palettes are more easily viewed under different lighting 

conditions. 

14.2.12 Show Markers - Fiducials 

When this option is turned on, fiducial markers will appear at the bottom of the cross-section as 

triangles labeled with the fiducial number. See section 8.5 for an example of a fiducial tag 

display. 

14.2.13 Show Markers - Skips 

When this option is turned on, skipped traces will appear at the bottom of the cross-section as 

rectangles. See section 8.5 for an example of a skipped trace tag display. 

14.2.14 Apply to All Cross-section Displays 

If this feature is active, all of the settings in this tab will be applied to all cross-section display 

windows. 
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14.3 Gain / Filter Tab 

The Gain / Filter tab contains options for changing the processing applied to the cross-section 

display. None of the processing done in SpiView modifies the data that is saved, this processing 

is done in real-time for display purposes only. 

 

Figure 14-3: View Settings menu, Gain / Filter tab 

14.3.1 Dewow 

Checking this item will perform Dewow processing to the cross-section display. Dewow removes 

unwanted low frequency ‘wow’ from the GPR traces while preserving high frequency signal. 

Wow is a slowly decaying low frequency signal that may be induced on the trace due to 

proximity of transmitter and receiver, or electrical properties of the ground. It is recommended 

that this setting remain on during data collection. 

14.3.2 Background 

Checking this item will perform Background Subtraction processing to the cross-section display. 

Background subtraction removes flat-lying background signal from the data. The average 

background signal is computed using a filter width defined by a number of traces. The 

background subtraction process is typically used when looking for localized targets; it should be 

turned off when trying to image flat lying structures. 
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14.3.3 Gain 

As GPR signals move through material they become attenuated. This means that the further the 

signals travel, the weaker they get by the time they reach the receiver. Gain is used to amplify 

weaker responses usually found at later times. 

SpiView can apply an SEC, Constant or no gain to the cross-section display.  

The SEC (Spreading and Exponential Compensation) gain applies a combined linear and 

exponentially increasing gain as a function of time. This gain compensates for the decrease in 

reflected signal amplitude cause by spherical wave front spreading and exponential attenuation 

caused by electrical conduction and volume scattering. The Attenuation parameter specifies the 

signal attenuation to compensate for. The Start parameter specifies the initial gain applied at the 

first break. The Maximum parameter specifies the maximum gain applied, once this value is 

reached the gain will remain constant. 

The Constant gain multiplies all data points by a constant factor. 

14.3.4 Apply to All Cross-section Displays 

If this feature is active, all of the settings in this tab will be applied to all cross-section display 

windows. 

14.4 GPS Tab 

The GPS tab controls the display and format of GPS status information. Options in this tab will 

only be displayed if the NIC has GPS enabled in the GPS Settings menu. 
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Figure 14-4: View Settings menu, Gain / Filter tab 

14.4.1 Show GPS Status in Cross-section 

When this feature is enabled, the GPS signal strength will displayed on the cross-sections as a 

bar graph indicating the number of satellites. The position quality will also be displayed as text 

beneath it. Below is a list of the status messages displayed: 

Disconnected (No data are being received) 
No Signal (Data are being received but there are no satellites in view) 
GPS 
DGPSRT2  
RT20 
Dead Reckoning  
Fixed Position 
Simulator 
WAAS 
Unknown 
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Figure 14-5: GPS status indicator appears in the lower left corner of the cross-section display. The number of green 

bars indicates the number of satellites in view. 

 

14.4.2 GPS Format 

The format of the GPS data displayed in the cross-section display status bar. The options 

include UTM and Lat/Long. When Lat/Long is selected, the operator can also choose to display 

in decimal degrees, decimal minutes, and decimal seconds. 

 

Figure 14-6: GPS status and current coordinates are displayed in the cross-section display status bar. 
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15 Scope Mode 

Scope mode serves two main purposes: 

1. To ensure that the GPR is functioning correctly 

2. To set the location of the transmit pulse within the recording window. 

Scope mode behaves differently based on the type of GPR being scoped. Noggin units are 

factory calibrated so that the first break can be set to specific location in the recording window. 

pulseEKKO PRO based units have their timing circuitry separated from the transmitter and 

receiver so the location of the transmit pulse will vary with the length of cables and the 

separation between the transmitter and receiver. Therefore it is much more important to 

properly scope pulseEKKO PRO based GPR units before data collection starts. 

To access scope mode click on the GPR Device item in the NIC Manager and select the Scope 

option. 

 

Figure 15-1: Scope mode is accessed by clicking on the GPR Device in the NIC Manager. 

When the Scope window appears, click the Start button to initialize the GPR unit and display 

trace data. The trace number will begin to count up in the status bar and the trace display will 

update in real-time. 
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Figure 15-2: Scope mode window showing trace data. The location of first break in this example is correct for normal 
data acquisition 

The scope window display the recording window previously set in the GPR Settings menu 

(Section 11.2). The vertical position of the GPR data can be changed within the recording 

window by simply clicking and dragging the trace up or down. Note that the data can be shifted 

completely off the top of the bottom of the recording window, in which case a flat looking vertical 

line will be all that appears within the window. If the transmit pulse is not visible, click the 

Automatic button to have SpiView search for the first break and place it near the top of the 

window. 
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Figure 15-3: Scope mode window showing trace data shifted further down in the recording window. This is incorrect 
for normal data acquisition. 

The red line at the top of the window indicates the Pre-time % set in the SpiView Preferences 

(Section 9.3.1). It is used as a guide when adjusting the location of the transmit pulse in the 

recording window. It is recommended that the first break of the transmit pulse be placed at 

about 10% of the recording window. This allows for sufficient data collected before the transmit 

pulse is received to analyze background noise levels. 

When the first break is in an acceptable location within the window, click the Accept button to 

save the value. This value is stored in the Window Time Shift field of the GPR Settings (Section 

11.2.4). 

Clicking Cancel will throw away any changes made to the Window Time Shift value. 

Scope mode should be performed on each GPR device before data collection. 
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16 Odometer Calibration 

The odometer on your platform should be periodically calibrated, perhaps once a week or once 

a month. It should also be re-calibrated if the ground surface which you are scanning changes, 

for example, from a grassy field to a paved parking lot. Calibrating on long lines ensures the 

highest accuracy. 

The odometer wheel calibration is done in the Platform Settings menu (Section 10.3.2.3), under 

the Acquisition tab. Click the Calibrate Odometer button to enter the Odometer Calibration 

menu. 

1. Pick an open area to perform a calibration on a material similar to the one that 

will be scanned when collecting data. 

2. Lay out a tape measure to the desired calibration length. The longer the line, 

the more accurate the calibration value will be. A calibration length of 5 or 10 m 

is recommended. 

3. In the Odometer Calibration menu, enter the Calibration Line Length. 

4. Align the origin of the platform with the start of the tape measure and click the 

Start button. 

5. Move the platform until the origin of the platform reaches the calibration line 

length according to the tape measure and click the Stop button. 

 

Figure 16-1: As the platform is moved, the number between the Start and Stop buttons will count up. 

6. The Old Calibration and the New Calibration values will be presented. Click the 

Accept button to save the New Calibration value, or click Cancel to keep the 

Old Calibration value. 
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Figure 16-2: Odometer Calibration menu. 

The calibration value chosen in the Odometer Calibration menu will appear in the Platform 

Settings dialog.  
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17 Starting a Project 

All data must be saved to a Project. A Project file (.GPZ) contains all of the data collected as 

part of that Project. SpiView also saves an uncompressed version of the line and grid data to a 

folder with the same name as the GPZ. 

17.1 Creating a New Project 

If the welcome screen is enabled from the Preferences menu (Section 9.2.2) the Getting Started 

dialog will appear when SpiView is first opened. Fill in the name of the new project and click the 

Create Project button. 

 

Figure 17-1: Getting Started dialog. 

A New Project can be started at any time by selecting File > New Project from the main menu or 

by clicking the blank area of the NIC Manager (Section 8.1) and selecting New Project. 

17.2 Open an Existing Project 

If the welcome screen is enabled from the Preferences menu (Section 9.2.2) the Getting Started 

dialog will appear when SpiView is first opened (Figure 17-1). To open an existing project, click 

the Browse for Project File and choose a previously made .GPZ file.  
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Figure 17-2: Browse for Existing Project dialog. 

If no Platform is defined when a Project is open, SpiView will present a list of Platforms that 

were used to collect data in the Project. Select one of the Platforms and click the Open button to 

load the settings from that Platform. Otherwise click Cancel to continue without loading a 

Platform. 

 

Figure 17-3: Open Existing Platform menu. 

The Open Existing Platform dialog can also be accessed by selecting File > Platform > Open 

from the main menu. A Project must already be opened for this function to work. 

17.3 Managing Files in a Project 

To view the lines and grids contained in the current project, click File > Manage Project to open 

the Project Management menu.  
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Figure 17-4: Project Management menu 

The Lineset folder contains all of the lines saved in Collect Line mode. Each collected grid will 

appear in its own folder. Expanding any folder will display the lines in that folder. Only one item 

is displayed per line, regardless of the number of GPR units on the platform when the line was 

collected. To view a line, highlight it and click the View button, this will attempt to open the data 

from each GPR in EKKO_View. To view a grid, highlight the grid folder and click View. This will 

attempt to open the grid in EKKO_Mapper. To delete a line or a folder, select the item and click 

the Delete button. Lines that are part of a grid cannot be deleted individually. 

Click the Close button to return to SpiView. 
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18 Collecting a Line 

18.1 Collect Line Without saving 

To collect a line without saving the data, select the Collect Line Without Saving option from the 

Collect Data button on the Platform Toolbar (Section 8.3.2) 

 

Figure 18-1: Collect Data drop down menu from the Platform toolbar 

18.2 Collect Line 

To collect a line and save the data, select the Collect Line option from the Collect Data drop 

down button (Figure 18-1) on the Platform Toolbar (Section 8.3.2). When saving a line, a 

separate set of files will be saved for each GPR device on the platform.  

18.2.1 Save New Line 

The Save New Line dialog will appear when the operator chooses to collect and save a new 

line. 

 

Figure 18-2: Save New Line dialog 

18.2.1.1 Line Prefix 

The Line Prefix is the text that precedes the line number in the saved file name. This text will be 

remembered from line to line. The Line Prefix may also be set blank. 
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18.2.1.2 Line Number 

The Line Number will automatically increment with each saved line if the Line Prefix remains the 

same. If the operator manually enters a line number that already exists, they will be asked to 

overwrite the files. The number of digits in the line number can be set in the Preferences menu 

(Section 9.2.5). If the line prefix is changed to one that was never used before, the numbering 

will be reset to 1. 

18.2.1.3 Start Position 

This is the position where the platform origin will start collecting data from. The line collected by 

each GPR will be offset by the Start Position and the GPR Offset defined as part of the Platform 

Settings (Section 10.4). 

18.2.1.4 Reverse Line Direction 

Turning the Reverse Line Direction option on will cause the line positioning to count down from 

the defined Start Position. This effectively gives the line a negative step size. 
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19 Collecting a Grid 

To collect a line as part of a grid, select the Collect Grid option from the Collect Data drop down 

button (Figure 18-1) on the Platform Toolbar (Section 8.3.2). Choosing to collect a grid will first 

open the Grid Definition menu. 

19.1 Grid Definition 

The Grid Definition menu allows the operator to set up the initial layout of the grid. During 

collection, lines can be added or removed and line position and direction can be modified but 

only one at a time. 

 

Figure 19-1: Grid Definition menu 

19.1.1 Grid Name 

This will be the name of the GFP file generated which can then be loaded into mapping software 

such as EKKO_Mapper. 

19.1.2 Grid Origin 

The origin of the grid can be offset in X and Y from some external reference point. This is useful 

if many grids are being collected in an area and the distance between each grid is known. 
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19.1.3 Grid Dimensions 

These define the overall dimensions of the Grid being collected. It is recommended that the grid 

dimensions be kept to a manageable size. Keep in mind that it may be difficult to collect straight 

lines over long distances. It is possible to collect many smaller grids and assemble them during 

processing in order to cover a larger area. The dimensions of the grid must be divisible by the 

Line Spacing. 

Changing the Grid Dimensions will automatically update the Number of Lines. 

19.1.4 Number of Lines 

The number of lines and line spacing in each direction can be defined independently. Changing 

the Number of Lines will automatically update the associated Grid Dimensions.   

19.1.5 Line Spacing 

The Line Spacing is usually governed by the frequency of the GPR and the size of the expected 

target. When looking for smaller objects, the line spacing should be decreased to produce 

higher resolution map images. When looking for larger objects, the line spacing may be 

increased to reduce the survey time or to cover a larger area. 

It is important to note that this line spacing defines the spacing between paths travelled by the 

platform origin, not the space between GPR sensors on the platform. For example, a 4 channel 

Noggin 1000 platform with 0.2 m spacing between the GPR sensors has an effective scan width 

of 0.6 m. In this case, the line spacing of the grid should be set to 0.8 m so that we end up with 

GPR data at 0.2 m intervals across the entire grid. 

For the most part it is recommended that the line spacing be equal in both directions. 

Changing the Line Spacing will automatically update the associated Grid Dimensions. 

 

Figure 19-2: Example 4 channel Noggin 1000 platform 
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19.1.6 Survey Format 

The Survey Format can be set to either Forward, or Forward / Reverse. In Forward mode, all 

lines are collected in the same direction starting on the grid axis and moving away from the grid 

origin.  

In Forward / Reverse mode, the first line is collected moving away from the grid origin, and the 

next line is collected moving towards it. Each line is collected in the opposite direction from the 

line before it. 

   

Figure 19-3: Example 5 m x 5 m grid with 0.5 m spacing collected using a survey format set to Forward (left), and the 
same grid using a Forward / Reverse survey format (right). 

19.1.7 Continue Grid 

Instead of creating a new grid, the operator may wish to continue a grid which was previously 

defined or even partially collected. The Continue Grid option will only be available if a previously 

defined grid already exists within the current project. To continue a grid, click the Continue Grid 

option and pick the desired grid from the drop down menu. 
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Figure 19-4: Grid Definition menu, continuing a grid 

19.1.8 Preview  

The Preview button shows the plot of the grid with the currently defined settings. Clicking 

anywhere in the window will close the preview and return to the Grid Definition menu. Using the 

preview allows the operator to check dimensions, line spacing and survey format before actually 

starting the grid collection. 
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Figure 19-5: Grid Preview window showing a newly defined grid 

When continuing a grid, the Preview button will display the grid selected and show the progress 

made. 

 

Figure 19-6: Grid Preview window showing a partially collected grid. Red lines indicated previously collected lines, 
while green lines are yet to be collected. 
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19.1.9 Defaults 

The Defaults button will return all settings to a standard 5 m x 5 m grid with 0.5 m line spacing 

or, if working in US Standard units, 15 ft x 15 ft with 1 ft line spacing. 

19.2 Grid Collection 

The Grid Collection menu guides the operator through collecting a grid.  

  

Figure 19-7: Grid Collection screen guides the operator through collecting each line of a grid 

19.2.1 Map View 

The Map View on the right side of the window displays all of the lines in the grid. Green lines still 

need to be collected, red lines have already been collected and the white line is the current line. 

The Map View displays the coordinates of the lower left and upper right of the grid, as well as 

the start and end coordinates for the current line. The direction of the line is indicated by the 

arrows on the end of each line. 

19.2.2 Current Platform Line 

The Line Type and Line Name of the currently active line are displayed in the two drop down 

lists. To change the currently active line, first pick the correct line type (either X or Y), then pick 

the name. The currently active line will also be indicated on the Map View as the white line. 
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19.2.3 Add New Line 

The Add New Line button will add another line to the end of the grid using the same line type 

that is currently selected and the originally defined line spacing. For example, if the originally 

defined line spacing for a 5 m x 5 m grid was 0.5 m and the currently selected line type was Y, 

the Add New Line button would add a new Y line at 5.5 m on the X axis. The new line can be 

moved after it is added to the desired location within the grid (Section 19.2.5). 

 

Figure 19-8: Adding a new line inserts a line past the end of the grid based on the defined line spacing and active line 
type. 

19.2.4 Remove Line 

The Remove Line button will remove the currently active line from the grid.  

19.2.5 Line Position and Orientation 

The location and orientation of a grid line can be changed by modifying the X, Y and the 

Reverse Direction options. To reverse the direction of a line, click the Reverse Direction 

checkbox and click the Apply Changes button. The change will update right away on the Map 

View. To change the start position of a line, change the X and Y parameters and click the Apply 

Changes button.  

It is recommended that the line be reversed before the start position is changed. Performing 

these steps in the opposite order may place the line in an undesired location. 
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19.2.6 Collect 

The Collect button will initialize the GPR devices allowing the operator to collect the active line. 

When the line is stopped, the Grid Collection menu will re-appear with the next line 

automatically selected.  

19.2.7 Done 

When the operator has completed the grid or wants to collect the rest of the grid later, the Done 

button will close the Grid Collection menu. The project will automatically be saved with the 

collected portion of the grid. 

19.2.8 Preview with EKKO_Mapper 

If at least two lines have been collected, the Preview with EKKO_Mapper button will become 

active. Clicking this button will open a temporary copy of the grid in EKKO_Mapper. If the 

EKKO_Mapper application cannot be found on the computer SpiView may ask to locate the 

program’s executable file. 
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20 File Types 

SpiView creates standard Sensors & Software file types for loading into software such as 

EKKO_View, EKKO_Mapper and EKKO_Interp 

20.1 GPR Project Files (.GPZ) 

SpiView creates GPR Project files (.GPZ) which can be loaded into EKKO_Interp. A GPZ file 

fully contains all GPR lines and grids.  

To ensure full compatibility with standalone applications such as EKKO_View, SpiView also 

saves a copy of all GPR lines and grids to a folder with the same name as the GPZ file. 

20.2 Platform Files (.PLT) 

All of the settings that make up the platform, GPR devices, GPS devices and view settings are 

stored in a platform file. The platform file is automatically saved inside the current project 

whenever a line is collected. 

The platform file can also be exported so that the same platform can be used with new projects. 

To export a platform file, click on the Platform item in the NIC Manager and choose Export 

Platform. Alternatively, navigate to File > Platform > Export from the SpiView main menu. 

To import a platform into a project, click on the blank space inside the NIC Manager and choose 

Import Platform. Alternatively, navigate to File > Platform > Import from the SpiView main menu.  
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21 Troubleshooting 

SPIDAR systems are designed to minimize user problems; however, all electronic devices are 

subject to possible failure.  The following are troubleshooting hints if your SPIDAR fails to 

operate or something wrong occurs. 

21.1 Trouble Detecting NICs 

If the NICs do not appear in the Platform Settings menu (Section 10.2) unassigned list please 

try the following: 

 Verify that the NIC or SPIDAR hub is connected to a 12 V power supply. Check all 

connections between the NICs, hub and PC 

 Try accessing the NIC admin page by navigating to the NIC’s IP address using a 

standard web browser (Section 6). The NIC’s IP address can be read from its LCD panel 

on startup.  

 Ensure that the Computer IP-Address set on the NIC admin page matches the IP 

address of the network interface on the PC (Section 5.1). 

 Disable the firewall on the host PC. 

 Close SpiView, disconnect power to the SPIDAR system, wait 30 seconds then re-apply 

power. Reopen SpiView and attempt to make a new platform. 

21.2 Intermittent Communication Failures 

The most common problem that can occur while trying to run a SPIDAR system is insufficient 

power. The more units attached to the SPIDAR system, the greater the power requirement. 

Voltage drops can occur along long cables and at connections. In many cases, the length and 

gauge of the power cables used may not be appropriate to support larger SPIDAR systems. 

 Each SPIDAR hub should be powered by its own power source. This will limit the power 

requirement on any one power source. 

 Ensure the power source can handle the current requirements. 

 Ensure the power cables can handle the current requirements. 

 Limit the length of power cables and the number of connections between the power 

source and SPIDAR hub. 

 Note that the more systems being used together, the less time a battery will last. Plan 

ahead and carry backup power sources into the field. 

 It is recommended to consult with a Sensors & Software Applications Specialist when 

designing a power distribution system. 

Typically, problems with the power distribution system will be experienced when the GPR 

devices are being detected; at this point the power requirements of the system increase and 

systems that are stressed to the point of failing will likely fail. 
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21.3 Creating a Test Line for Data Quality 

One of the best ways of detecting problems with any GPR system is compare new data with 

data collected previously along the same line.  

Soon after receiving the system and getting comfortable with its operation, collect a line of data 

at a convenient, easily accessible location. The line does not have to be too long but 5-10 

metres (15-30 feet) is a good guide. This data line should be saved electronically and perhaps 

plotted out on paper and dated. The test line should them be collected on regular intervals, say 

every 6 months and, by reviewing the previous data, system problems can be detected early. As 

well, if there is a suspected problem with the system, this test line could be collected and 

compared with earlier tests.  

21.4 Contacting Sensors & Software Inc. 

If you develop problems with your SPIDAR system, contact your agent or Sensors & Software 

Inc.  

Sensors & Software Inc.’s hours of operation are 9:00 AM to 5:00 PM Eastern Standard Time, 

Monday to Friday. You can contact Sensors & Software Inc. at: 

Sensors & Software Inc. 
1040 Stacey Court 

Mississauga, Ontario 
Canada L4W 2X8 

Tel: (905) 624-8909 
Fax: (905) 624-9365 

E-mail: radar@sensoft.ca 
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21.5 Error Codes 

SpiView will report error codes which can help isolate and troubleshoot any problems 

encountered. Below is a table of error codes and likely causes. 

Error Code Description Possible Causes 

-4 General communication 
error 

Usually occurs when communication is lost between 
the NIC and the GPR device. This may indicate a loss 
of or insufficient power. 

701 - 704 NIC communication error Usually occurs when communication is lost between 
the NIC and the PC. 

710 GPS and DynaQ 
enabled 

GPS and DynaQ cannot be enabled on the same 
NIC. 

800 GPR not supported The GPR device attached to this NIC is not supported 
by SpiView 

802 Failed to read GPR 
device info 

May indicate a loss of or insufficient power to the GPR 
unit. May also indicate a problem with the GPR 
hardware 

804 GPR type mismatch The GPR device defined in the GPR settings does not 
match the GPR device actually attached 

805 Frequency mismatch The frequency defined in the GPR settings is not the 
frequency of the GPR device actually attached 

806 Invalid frequency The frequency defined in the GPR settings is not 
supported by the GPR device 

807 Invalid antenna 
separation 

The antenna separation defined in the GPR settings 
does not match the antenna separation of the GPR 
device 

810 GPR not detected No GPR device was detected on this NIC 

811 Transmitter not 
responding 

The transmitter on the GPR device is not responding 

812  Receiver not responding The receiver on the GPR device is not responding 

816 Invalid trace interval The trace interval is not supported by the pseudo 
odometer 

817 Invalid step size and 
odometer cal 
combination 

The desired step size and odometer calibration 
cannot be used 

818 Invalid frequency and 
pulse voltage 
combination 

The desired pulse voltage is not allowed with this 
frequency of GPR 

820 Monostatic WARR not 
allowed 

A monostatic GPR device cannot be used to perform 
a CMP / WARR survey 
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Appendix A: Health & Safety Certification 

Radio frequency electromagnetic fields may pose a health hazard when the fields are intense.  

Normal fields have been studied extensively over the past 30 years with no conclusive 

epidemiology relating electromagnetic fields to health problems.  Detailed discussions on the 

subject are contained in the references and the web sites listed below. 

The USA Federal Communication Commission (FCC) and Occupational Safety and Health 

Administration (OSHA) both specify acceptable levels for electromagnetic fields.  Similar power 

levels are mandated by corresponding agencies in other countries.  Maximum permissible 

exposures and time duration specified by the FCC and OSHA vary with excitation frequency.  

The lowest threshold plane wave equivalent power cited is 0.2 mW/cm2 for general population 

over the 30 to 300 MHz frequency band.  All other applications and frequencies have higher 

tolerances as shown in graphically in Figure B-1. 

 

Figure B-1: FCC limits for maximum permissible exposure (MPE) plane-wave equivalent power 

density mW/cm2. 

All Sensors & Software Inc. GPR products are normally operated at least 1 m from the user and 

as such are classified as “mobile” devices according to the FCC.  Typical power density levels 

at a distance of 1 m or greater from any Sensors & Software Inc. product are less than 10-3 

mW/cm2 which are 200 to 10,000 times lower than mandated limits.  As such, Sensors & 

Software Inc. products pose no health and safety risk when operated in the normal manner of 

intended use.  
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Appendix B: GPR Emissions, Interference and 
Regulations 

 

All governments have regulations on the level of electromagnetic emissions that an electronic 

apparatus can emit.  The objective is to assure that one apparatus or device does not interfere 

with any other apparatus or device in such a way as to make the other apparatus non-

functional.   

The manufacturer test their GPR products using independent professional testing houses and 

comply with latest regulations of the USA, Canada, European Community, and other major 

jurisdictions on the matter of emissions.  

Electronic devices have not always been designed for proper immunity.  If a GPR instrument is 

placed in close proximity to an electronic device, interference may occur.  While there have 

been no substantiated reports of interference to date, if any unusual behavior is observed on 

nearby devices, test if the disturbance starts and stops when the GPR instrument is turned on 

and off.  If interference is confirmed, stop using the GPR.   

Where specific jurisdictions have specific GPR guidelines, these are described below. 

FCC Regulations 

This device complies with Part 15 of the USA Federal Communications Commission (FCC) 

Rules.  Operation in the USA is subject to the following two conditions: 

this device may not cause harmful interference and 

 

this device must accept any interference received, including interference that may cause 

undesired operation. 

Part 15 – User Information 

 

This equipment has been tested and found to comply with the limits for a Class A digital device, 

where applicable, and for an ultrawide bandwidth (UWB) device where applicable, pursuant to 

Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against 

harmful interference when the equipment is operated in a commercial environment. This 

equipment generates, uses and can radiate radio frequency energy and, if not installed and 

used in accordance with the instruction manual, may cause harmful interference to radio 

communications. Operation of this equipment in a residential area is likely to cause harmful 

interference in which case the user will be required to correct the interference at his own 

expense. 

WARNING 
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Changes or Modifications not expressly approved by the manufacturer could void the user’s 

authority to operate the equipment. 

Certification of this equipment has been carried out using approved cables and peripheral 

devices.  The use of non-approved or modified cables and peripheral devices constitutes a 

Change or Modification outlined in the warning above. 

Operating Restrictions 

 

Operation of this device is limited to purposes associated with law enforcement, firefighting, 

emergency rescue, scientific research, commercial mining, or construction. Parties operating 

this equipment must be eligible for licensing under the provisions of Part 90 of this chapter.  

FCC Interpretation of Operation Restrictions issued July 12, 2002 

(FCC Order DA02-1658, paragraph 9) 

 

The regulations contain restrictions on the parties that are eligible to operate imaging systems 

(See 47 C.F.R. 5.509(b), 15.511(b), and 15.513(b)).  Under the new regulations, GPRs and wall 

imaging systems may be used only by law enforcement, fire and emergency rescue 

organizations, by scientific research institutes, by commercial mining companies, and by 

construction companies.  Since the adoption of the Order, we have received several inquiries 

from the operators of GPRs and wall imaging systems noting that these devices often are not 

operated by the users listed in the regulations but are operated under contract by personnel 

specifically trained in the operation of these devices.  We do not believe that the recent adoption 

of the UWB rules should disrupt the critical safety services that can be performed effectively 

only through the use of GPRs and wall imaging systems.  We viewed these operating 

restrictions in the broadest of terms.  For example, we believe that the limitation on the use of 

GPRs and wall imaging systems by construction companies encompasses the inspection of 

buildings, roadways, bridges and runways even if the inspection finds no damage to the 

structure and construction does not actually result from the inspection; the intended purpose of 

the operation of the UWB device is to determine if construction is required.  We also believe that 

the GPRs and wall imaging systems may be operated for one of the purposes described in the 

regulations but need not be operated directly by one of the described parties.  For example, a 

GPR may be operated by a private company investigating forensic evidence for a local police 

department.   

FCC Permitted Mode of Usage 

 

The GPR antenna must be kept on the surface to be in compliance with FCC regulations.  Use 

of the antenna is not permitted if it is lifted off the surface.  Use as a through-the-wall imaging 

device is prohibited.   

GPR Use Coordination 
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FCC regulation 15.525(c) (updated in February 2007) requires users of GPR equipment to 

coordinate the use of their GPR equipment as described below:  

TITLE 47--TELECOMMUNICATION  

CHAPTER I--FEDERAL COMMUNICATIONS COMMISSION 

PART 15_RADIO FREQUENCY DEVICES 

Subpart F_Ultra-Wideband Operation Sec. 

15.525  Coordination requirements. 

    (a) UWB imaging systems require coordination through the FCC before the equipment may 

be used. The operator shall comply with any constraints on equipment usage resulting from this 

coordination. 

    (b) The users of UWB imaging devices shall supply operational areas to the FCC Office of 

Engineering and Technology, which shall coordinate this information with the Federal 

Government through the National Telecommunications and Information Administration. The 

information provided by the UWB operator shall include the name, address and other pertinent 

contact information of the user, the desired geographical area(s) of operation, and the FCC ID 

number and other nomenclature of the UWB device. If the imaging device is intended to be 

used for mobile applications, the geographical area(s) of operation may be the state(s) or 

county(ies) in which the equipment will be operated. The operator of an imaging system used 

for fixed operation shall supply a specific geographical location or the address at which the 

equipment will be operated. This material shall be submitted to: 

Frequency Coordination Branch, OET  

Federal Communications Commission  

445 12th Street, SW, Washington, D.C.  

20554  

Attn: UWB Coordination 

(Sensors & Software Inc. Note: The form given on the following page is a suggested format for 

performing the coordination.) 

    (c) The manufacturers, or their authorized sales agents, must inform purchasers and users of 

their systems of the requirement to undertake detailed coordination of operational areas with the 

FCC prior to the equipment being operated. 

    (d) Users of authorized, coordinated UWB systems may transfer them to other qualified users 

and to different locations upon coordination of change of ownership or location to the FCC and 

coordination with existing authorized operations. 
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    (e) The FCC/NTIA coordination report shall identify those geographical areas within which the 

operation of an imaging system requires additional coordination or within which the operation of 

an imaging system is prohibited. If additional coordination is required for operation within 

specific geographical areas, a local coordination contact will be provided. Except for operation 

within these designated areas, once the information requested on the UWB imaging system is 

submitted to the FCC no additional coordination with the FCC is required provided the reported 

areas of operation do not change. If the area of operation changes, updated information shall be 

submitted to the FCC following the procedure in paragraph (b) of this section. 

    (f) The coordination of routine UWB operations shall not take longer than 15 business days 

from the receipt of the coordination request by NTIA. Special temporary operations may be 

handled with an expedited turn-around time when circumstances warrant. The operation of 

UWB systems in emergency situations involving the safety of life or property may occur without 

coordination provided a notification procedure, similar to that contained in Sec. 2.405(a) through 

(e) of this chapter, is followed by the UWB equipment user.[67 FR 34856, May 16, 2002, as 

amended at 68 FR 19751, Apr. 22, 2003] 

    Effective Date Note: At 68 FR 19751, Apr. 22, 2003, Sec. 15.525 was amended by revising 

[[Page 925]] paragraphs (b) and (e). This amendment contains information collection and 

recordkeeping requirements and will not become effective until approval has been given by the 

Office of Management and Budget.  
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FCC GROUND PENETRATING RADAR COORDINATION NOTICE 

NAME: 

ADDRESS: 

CONTACT INFORMATION [CONTACT NAME AND PHONE NUMBER]: 

AREA OF OPERATION [COUNTIES, STATES OR LARGER AREAS]: 

FCC ID:  QJQ-NG250 

EQUIPMENT NOMENCLATURE:  NG250  

 

Send the information to: 

Frequency Coordination Branch., OET 

Federal Communications Commission 

445 12th Street, SW 

Washington, D.C.  20554 

ATTN:  UWB Coordination 

Fax:       202-418-1944 

 

INFORMATION PROVIDED IS DEEMED CONFIDENTIAL 
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ETSI Regulations for the EC (European Community) 

In the European Community (EC), GPR instruments must conform to ETSI (European Technical 

Standards Institute) standard EN 302 066-1 v1.2.1.  Details on individual country requirements 

for licensing are coordinated with this standard.  For more information, contact Sensors & 

Software’s technical staff. 

All Sensors & Software ground penetrating radar (GPR) products offered for sale in European 

Community countries or countries adhering to ETSI standards are tested to comply with EN 302 

066 v1.2.1. 

For those who wish to get more detailed information, they should acquire copies of the following 

documents available from ETSI. 

ETSI EN 302 066-1 V1.2.1 (February 2008) Electromagnetic compatibility and Radio spectrum 

Matters (ERM); Ground and Wall- Probing Radar applications (GPR/WPR) imaging systems; 

Part 1: Technical characteristics and test methods 

ETSI EN 302 066-2 V1.2.1 (February 2008) Electromagnetic compatibility and Radio spectrum 

Matters (ERM); Ground and Wall- Probing Radar applications (GPR/WPR) imaging systems; 

Part 2: Harmonized EN covering essential requirements of article 3.2 of the R&TTE Directive 

ETSI TR 101 994-2 V1.1.2 (March 2008) Electromagnetic compatibility and Radio spectrum 

Matters (ERM); Short Range Devices (SRD); Technical characteristics for SRD equipment using 

Ultra Wide Band technology (UWB); Part 2: Ground- and Wall- Probing Radar applications; 

System Reference Document 
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Industry Canada Regulations - English 

 

Industry Canada published it regulations for ground penetrating radar (GPR) on Mar 29 2009 as 

part of the RSS-220 titled 'Devices Using Ultra-Wideband (UWB) Technology'. 

Industry Canada has made a unique exception for GPR by not requiring user licensing.  The 

user does have to comply with the following directives: 

This Ground Penetrating Radar Device shall be operated only when in contact with or within 1 m 

of the ground. 

This Ground Penetrating Radar Device shall be operated only by law enforcement agencies, 

scientific research institutes, commercial mining companies, construction companies, and 

emergency rescue or firefighting organizations. 

Should the ground penetrating radar be used in a wall-penetrating mode then the following 

restriction should be noted by the user: 

This In-wall Radar Imaging Device shall be operated where the device is directed at the wall 

and in contact with or within 20 cm of the wall surface. 

This In-wall Radar Imaging Device shall be operated only by law enforcement agencies, 

scientific research institutes, commercial mining companies, construction companies, and 

emergency rescue or firefighting organizations. 

Since operation of GPR is on a license-exempt basis, the user must accept the following: 

Operation is subject to the following two conditions: (1) this device may not cause interference, 

and (2) this device must accept any interference, including interference that may cause 

undesired operation of the device.  
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Règlement d'Industrie Canada - Français 

Industrie Canada a publié des règlements pour les appareils géoradar (GPR) le 29 mars 2009, 

dans le cadre du RSS-220 intitulé "Dispositifs utilisant la bande ultra-large (UWB)". 

Industrie Canada a faite une exception unique pour GPR en n'exigeant pas de licence par 

utilisateur. L'utilisateur doit se conformer aux directives suivantes: 

Ce géoradar périphérique doit être utilisé que lorsqu'il est en contact avec ou moins de 1 m du 

sol. 

Ce géoradar périphérique doit être utilisé que par les organisations d'application de la loi, les 

instituts de recherche scientifique, des sociétés minières commerciales, entreprises de 

construction et de secours d'urgence ou des organisations de lutte contre les incendies. 

Si le géoradar est utilisé dans un mode de pénétration au mur, la restriction suivante est à noter 

par l'utilisateur: 

Ce dispositif d'imagerie radar doit être utilisé lorsque l'appareil est orienté vers le mur et en 

contact avec ou dans les 20 cm de la surface du mur. 

Ce dispositif d'imagerie radar doit être utilisé que par les organisations d'application de la loi, les 

instituts de recherche scientifique, des sociétés minières commerciales, entreprises de 

construction et de secours d'urgence ou des organisations de lutte contre les incendies. 

Parce que l'exploitation de GPR est sur une base exempte de licence, l'utilisateur doit accepter 

le texte suivant: 

La fonctionnement est soumis aux deux conditions suivantes: (1) cet appareil ne peut pas 

provoquer d'interférences et (2) cet appareil doit accepter toute interférence, y compris les 

interférences qui peuvent causer un mauvais fonctionnement du dispositive 
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Appendix C: Instrument Interference 

Immunity regulations place the onus on instrument/apparatus/device manufacturers to assure 

that extraneous interference will not unduly cause an instrument/apparatus/device to stop 

functioning or to function in a faulty manner. 

Based on independent testing house measurements, Sensors & Software Inc. systems comply 

with such regulations in Canada, USA, European Community and most other jurisdictions. GPR 

devices can sense electromagnetic fields.  External sources of electromagnetic fields such as 

TV stations, radio stations and cell phones, can cause signals detectable by a GPR which may 

degrade the quality of the data that a GPR device records and displays. 

Such interference is unavoidable but sensible survey practice and operation by an experienced 

GPR practitioner can minimize such problems. In some geographic areas emissions from 

external sources may be so large as to preclude useful measurements. Such conditions are 

readily recognized and accepted by the professional geophysical community as a fundamental 

limitation of geophysical survey practice.  Such interference being present in the GPR 

recordings is not considered as an equipment fault or as a failure to comply with immunity 

regulations.   
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Appendix D: Safety Around Explosive Devices 

 

Concerns are expressed from time to time on the hazard of GPR products being used near 

blasting caps and unexploded ordnance (UXO). Experience with blasting caps indicates that the 

power of Sensors & Software Inc.’s GPR products are not sufficient to trigger blasting caps. 

Based on a conservative independent testing house analysis, we recommend keeping the GPR 

transmitters at least 5 feet (2m) from blasting cap leads as a precaution.  Some customers do 

experimental trials with their particular blasting devices to confirm with safety.  We strongly 

recommend that GPR users routinely working with explosive devices develop a systematic 

safety methodology in their work areas.   

The UXO issue is more complex and standards on fuses do not exist for obvious reasons. To 

date, no problems have been reported with any geophysical instrument used for UXO. Since 

proximity and vibration are also critical for UXO, the best advice is to be cautious and 

understand the risks. 
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